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Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.

 l Document Release Date, which changes each time the document is updated.

 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go 
to:

      http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport 
ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support 
service. Contact your HP sales representative for details.

HP Service Manager (9.32)Page 3 of 55

Patch 2 Release Notes



Support
Visit the HP Software Support Online web site at:

      http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support 
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a 
valued support customer, you can benefit by using the support web site to:

 l Search for knowledge documents of interest

 l Submit and track support cases and enhancement requests

 l Download software patches

 l Manage support contracts

 l Look up HP support contacts

 l Review information about available services

 l Enter into discussions with other software customers

 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp
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What's New in This Release
This section describes important changes in this release. 

Warning when Running the Server on Solaris 9 with 
JRE 6

In SM9.31 p2 and later patches, the server's JRE version was upgraded to JRE7. When Service 
Manager started, it performed a JRE validation that did not allow a JRE version below JRE7 
update15. However, JRE7 is not supported by Solaris 9. Therefore, Service Manager could not 
start on Solaris 9-based systems.

In SM9.32p1, customers used a workaround to address this issue. As of this release, this issue is 
fixed.  You can run Service Manager on Solaris 9 with JRE 6 or later. However, HP recommends 
that you upgrade to Solaris 10 to take advantage of JRE 7. When you start the Service Manager 
server on Solaris 9, the following warning will be displayed:

Service Manager runs on Solaris 9 with jre6 as Solaris 9 does not support jre7. 
We recommend you to run on Solaris 10 with jre7.

Extra configuration required for Solaris 9

If you still want to run the server on Solaris 9, an extra configuration is required. Without this 
configuration, when you start the SM server, the following error will occur: "fatal: libm.so.2: 
open failed: No such file or directory." This is a fundamental problem of Solaris 9, 
because there is no "libm.so.2" on Solaris 9, while the Service Manager server requires this 
"libm.so.2" to work.

Use the following configuration to avoid this issue:

 1. Log in to server host as a root user

 2. Run the following commands to create a link between limb.so.1 and limb.so.2:

 n cd /usr/lib

 n ln -s libm.so.1 libm.so.2

 3. Run the export LD_NOVERSION=1 command to set the environment variable LD_
NOVERSION.

 4. Start the SM server. The server is started successfully.

 

New Text Strings to Be Localized
This release has introduced a new text string, which customers can easily localize using the 
native2ascii tool. 
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Naming Convention of Localized Files
Localized versions of resource files use the following naming convention: <basename>_<language_
code>.properties or <basename>_<language_code>_<country_code>.properties. 

Note: The file names are case-sensitive.

The following are two examples.

Example File Description 

cpe_rcp_en.properties “cpe_rcp” is the base name, and “en” is the language code.

cwc_labels_zh_
CN.properties

“cwc_labels” is the base name, “zh” is the language code, and “CN” 
is the country code.

For a list of language codes (and country codes if any) used in the file names of localized resource 
files, see the following table.

Language Code Country Code Description

  Default

en  English

ar  Arabic

cs  Czech

de  German (Standard)

es  Spanish (Spain)

fr  French (Standard)

hu  Hungarian

it  Italian (Standard)

ja  Japanese

ko  Korean

zh CN Chinese (PRC)

nl  Dutch (Standard)

pt BR Portuguese (Brazil)

ru  Russia
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Service Manger uses UTF-8 as the default encoding when interpreting the resources. It requires all 
resources files in native UTF-8 encoding be converted to files containing Latin-1 and/or Unicode-
encoded characters, using the native2ascii tool.

New Text Strings to Be Localized
The following table lists the added text string in the Web tier  of this release, as well as the 
corresponding properties file.

Added Text String Description

<webtier-9.32.war>/WEB-INF/classes/chMBundle.properties 

Added:

 l CIRCULAR_DEPENDENCY=Circular dependencies are not 
allowed in Task Planner. Break the circle before 
you continue.

New string is added for 
circular dependencies in 
Task Planner

How to Localize New Text Strings
Step 1. Set up the Java development environment on Windows.

 1. Download and install Java Standard Edition 6 or later.

 2. Set the JAVA_HOME variable and add <JAVA_HOME>/bin to the system path.

 3. Open the system command prompt, and run the following command to check if Java has been 
correctly configured:

java  -version

Note: If your Java development environment is ready, this command will print your Java 
version information.

Step 2. Convert the text in a specific language to Unicode.

As an example, the following provides the localization steps for Japanese. The steps for other 
languages are similar.

 1. Translate the added resource text to the target languages, and put the translated text in a text 
file for each language: <basename>_<language>.txt.

 2. Merge your translated recourse text for all properties files into one file, so that you can convert 
all of the text in one go. For instance, for Japanese, put the translated text in sm_RES_ja.txt.
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Note: Make sure its file encoding is UTF-8 (You can copy an existing file in Service 
Manger and then edit it).

The following is an example of translated text, which is provided for demonstration purposes 
only.

# From chMBundle.properties

TITLE=タスクプランナー

MANDATORY=必要に応じてマーク\ /読み取り専用の変更のようにプロパティを設定します。

TASK_CONDITION=タスクの状態

END_PHASE_INVALID=エンドフェイズでは、スタートフェーズの後に発生する必要があります

#From cwc_labels.properties 

Framework.CollapseNav=崩壊·ナビゲータ

Framework.ExpandNav=ナビゲータを展開

Framework.CommandLineField=コマンドライン

Framework.CommandLineBtn=実行する

cwc.skipLink=スキップしてメインページに進む

 3. Copy sm_RES_ja.txt to a local folder. For example: C:\sm932p2.

 4. Open the system command prompt, and change current directory to the local folder you 
selected in the previous step (for example:C:\sm932p2).

 5. Run the following native2ascii command to convert the text.

native2ascii -encoding utf-8 sm932p1_RES_ja.txt  sm_RES_ja.properties

The converted text should look like the following (the following text is provided for 
demonstration purposes only).

#From cwc_labels.properties

Framework.CollapseNav=\u5d29\u58ca\u00b7\u30ca\u30d3\u30b2\u30fc\u30bf

Framework.ExpandNav=\u30ca\u30d3\u30b2\u30fc\u30bf\u3092\u5c55\u958b

Framework.CommandLineField=\u30b3\u30de\u30f3\u30c9\u30e9\u30a4\u30f3

Framework.CommandLineBtn=\u5b9f\u884c\u3059\u308b

cwc.skipLink=\u30b9\u30ad\u30c3\u30d7\u3057\u3066\u30e1\u30a4\u30f3\u30da\

u30fc\u30b8\u306b\u9032\u3080
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Tip: For more information on the usage of the native2ascii tool, see 
http://docs.oracle.com/javase/1.4.2/docs/tooldocs/windows/native2ascii.html . 

Step 3. Append the localized new strings to the localized version of the resource files.

 1. In the sm_RES_ja.properties file, copy the lines from cwc_labels.properties to 
<webtier-9.3x>/WEB-INF/classes/com/hp/ov/cwc/web/cwc_labels_ja.properties.

 2. In the sm_RES_ja.properties file, copy the lines from each of the remaining properties files 
and append them to the Japanese version of the files.

Now, the localization process for Japanese is complete.

 3. Restart your web application server and Windows client.
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Fixed Defects
This release fixes the following defects.

Server

CR Problem Solution

QCCR1E99113 Queries on customized join tables return incorrect results. Queries on customized join tables return 
correct results.

QCCR1E99174 The Global List field validation that is defined in Data Policy for an array 
field is ignored in RecordList.

The Global List field validation that is 
defined in Data Policy for an array field is 
performed in RecordList.

QCCR1E99380 After you upgrade to Service Manager 9.31, you found garbled characters 
when Service Manager sends data to an external server via 
doHTTPRequest.

The correct charset is added to the 
Content-Type HTTP header if the charset is 
not provided. Therefore, the receiver can 
decode the body by using the correct 
charset.

QCCR1E99414 When Service Manager acts as a Web Services client, it cannot 
successfully consume a Web Service from a third-party server.
 

When Service Manager acts as a Web 
Services client, it can successfully 
consume a Web Service from a third-party 
server.
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QCCR1E99398 The inactive timer function does not work if the version of applications is 
lower than the server version. For example, the inactive timer function 
does not work on Service Manager 9.32 server where Service Manager 
9.31 or 9.30 applications run.

The inactive timer function now works as 
expected when the version of applications 
is lower than the server version.

QCCR1E99655 After you upgrade to Service Manager server  9.30p5 or later, the CPU 
load on the database server is very high. This is caused by the IRQUEUE 
process. 

The CPU load on the database returns to 
normal.

QCCR1E99897 An error occurs during login after you upgrade RTE from 9.31 to 9.32. This 
issue happens when you try to add a new scacess record.

The error does not occur  when you add a 
new scaccess record.

QCCR1E99940 This patch upgrades the JRE version to JRE7. When Service Manager 
starts, it performs a JRE validation that does not allow a JRE version 
below JRE7 update15. However, JRE7 is not supported by Solaris 9. 
Therefore, Service Manager does not start on Solaris 9-based systems.

You no longer need to apply the workaround 
to run Service Manager on Solaris 9 with 
JRE 6.

Service Manager can run on Solaris 9 with 
JRE 6 upgrade 20 or later as well as other 
platforms with JRE 7.

For more information, see "Warning when 
Running the Server on Solaris 9 with JRE 
6" on page 7.

QCCR1E100033 Attachments are stored but not related to records. Attachments can now be related to records 
after Service Manager retrieves the correct 
primary key value of the contacts table.

QCCR1E100440 An error occurs when you run the following command:
sm -que:ir

The error does not occur when you run the 
following command: 
sm -que:ir
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QCCR1E100607 You cannot select records  from a custom view, and the session 
terminates with an error. This issue only occurs in Linux.

You can select records from a custom view 
without the error.

QCCR1E100686 The following message is printed in the sm log:
JRTE W Process Low on Java Memory.
 

The following message is no longer printed 
in the sm log:
JRTE W Process Low on Java Memory.

QCCR1E101415 When you enter  Chinese characters that are more than database 
limitation in Description field of Task Planner, besides the expected error 
"Length (xxx bytes) of data for field brief.desc in cm3t 
exceeds max (xxx bytes), truncated 
(se.base.method,add.record.radd)", the following extra error 
message is displayed:

The record being updated has been modified since read 
(se.base.method,update.record)

When you enter Chinese characters that 
are more than database limitation in 
Description field of Task Planner, the extra 
error message is no longer displayed. Only 
the expected error message is displayed.

QCCR1E95743 The following message in the log does not provide any valuable 
information, and should be removed:

Lock is already obtained by someone else.

This message is removed from the log.

QCCR1E96676 The following message in the log is no longer applicable, and should be 
removed.

SQL shadow flag ignored for table %s. This flag is obsolete

This message is removed from the log.

QCCR1E100142 The rtecall("getunique") function returns no results for a record when the 
parameter primary_key_mode is enabled.

The rtecall("getunique") function returns 
Unique key values for records when the 
parameter primary_key_mode is enabled.

Web Client

CR Problem Solution
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QCCR1E68206 In Internet Explorer, Case Conversion for the 
Assignment Group field is not executed when 
you fill the field and press Enter.

In Internet Explorer, Case Conversion for the Assignment Group 
field is executed when you fill the field and press Enter.

QCCR1E97539 If your browser uses JRE, and you upgrade JRE 
to version 1.7.0_21 or later, the following warning 
message appears when you open a configuration 
item in the Service Manager web client:
Block potentially unsafe components from 
being run?

To resolve this issue, affected applets have been repackaged in 
the web tier.

Note: Even after the applets are repackaged, a security 
prompt with a blue information shield dialog  appears. 
To prevent the security prompt from appearing again, check 
the “Do not show this again…” checkbox and then click Run.

For detailed information, go to the following HP web site: 
http://support.openview.hp.com/selfsolve/document/KM0066075
3
 

QCCR1E99175 The Global List field validation that is defined in 
Data Policy for an array field is ignored in 
RecordList.

The Global List field validation that is defined in Data Policy for an 
array field is performed in RecordList.

QCCR1E100077 You can input no more than 30  characters in the 
Description field in Task Planner.

The character limit of the Description field in Task Planner is 
removed. However, if a task is stored in cm3t, you receive the 
following error message from the database if the string input in the 
Description field is longer than the database limits:
 Length (xxx bytes) of data for field brief.desc in 
cm3t exceeds max (xxx bytes), truncated 
(se.base.method,add.record.radd).
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QCCR1E100277 If you set values for both the Name and 
Description fields for a WorkflowPhase record, 
and the value of the Description field is more user 
friendly, and then view the list values of the Start 
Phase and End Phase combo boxes in the Task 
Planner, you will find that the value of the Name 
field is displayed for the previously modified 
WorkflowPhase record, instead of the value of 
the Description field. 

In the Task Planner, Start Phase and End Phase are respectively 
displayed as Open In Phase and Close By Phase which are more 
meaningful. Additionally, the value of the Description field of a 
WorkflowPhase record is displayed in the Open In Phase and 
Close By Phase combo boxes. This makes the list values in the 
Open In Phase and Close By Phase combo boxes more user 
friendly.

Known Issue:

If single quotes or double quotes are used in the Description field,  
they are displayed normally in the drop down list, however, they 
are displayed as their HTML encoded values in the input box . For 
example, single quotes are displayed as &#39; and double quotes 
are displayed as &#34;.

QCCR1E100382 In the Task Editor, the value lists of the Start 
Phase and End Phase do not change with the 
selection change of the Task Category. All 
phases in the workflow are listed, including those 
phases that are not available to the selected 
Task Category. You are also able to save an 
unavailable phase for a Task Category.

In the Task Editor, Start Phase and End Phase are respectively 
displayed as Open In Phase and Close By Phase which are more 
meaningful. Additionally, the value lists of  Open In Phase and 
Close By Phase change with the selection change of the Task 
Category. Only available phases are displayed in the combo 
boxes. Moreover, only future phases are listed in the Close By 
Phase combo box after you select a value for Open In Phase.

Known issue:

If there are circular dependencies among the phases in the 
workflow, the value list for the Close By Phase combo box may 
not be accurate.
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QCCR1E100590 In Process Designer, the Change Task Planner 
allows the creation of circular dependencies 
between Tasks.

If Service Manager detects circular dependencies in the Change 
Task Planner, the following error message appears:

Circular dependencies are not allowed in Task Planner. 
Break the circle before you continue. 

If you do not take any actions, this error message appears again 
when you try to save the graph information by clicking OK. The 
graph can only be saved when no circular dependency is detected.

QCCR1E101872 If you view a Change record on a PDCP4 system 
with a large number of records in the cm3groups 
table, it takes more time than expected before the 
page is completely loaded.

If you view a Change record on a PDCP4 system with a large 
number of records in the cm3groups table, it takes short time 
before the page is completely loaded.

Windows Client

CR Problem Solution

QCCR1E99174 The Global List field validation that is defined in 
Data Policy for an array field is ignored in 
RecordList.

The Global List field validation that is defined in Data Policy for an 
array field is performed in RecordList.

Packaging

CR Problem Solution
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QCCR1E100791 The SMDoctor directory is not found if you 
upgrade to SM9.32p1 from the following versions 

 l SM9.30 GA

 l SM9.30 Patch/Hotfix 

 l SM9.31 

 l SM9.31 Patch/Hotfix

Note: If you upgrade Service Manager from 
version 9.32 to 9.32p1, the directory exists.

The SMDoctor directory is  built with Service Manager 9.32 RTE 
package. And SM Doctor  is bounded in the server patch. 
Extracting the server patch, you can find the smdoctor folder in the 
same hierarchical level with RUN.
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Known Problems, Limitations, and Workarounds
This software release has the following known issues and limitations. This is a cumulative list of known issues and limitations in Service 
Manager 9.32, including those that are already documented in previous release notes (Service Manager 9.31 and patches). These known 
issues and limitations were found in SM9.31 GA, SM9.31 patches, SM9.32 GA, or SM9.32 patches, and still exist in SM9.32p2.

Issues  in SM9.31 and Patches

Global ID Problem Workaround

QCCR1E63663 The Service Manager (SM) client loses 
connectivity during JavaScript execution of the 
file.list RAD application.

No workaround available.

Created a knowledge article (KM1166532), 
which states that Service Manager does not 
currently support calls from JavaScript on RAD 
applications that use the rio/fdisp panels.

HP Service Manager (9.32)Page 19 of 55

Patch 2 Release Notes
Known Problems, Limitations, and Workarounds



Global ID Problem Workaround

QCCR1E57385 When Service Manager is running on Unix, the 
legacy listener may log intermittent signal 11 
upon CIT initial connectivity test if exec-shield 
is not set properly.

Use one of the following solutions to solve this 
issue on Unix.

Solution 1:

Connect Connect-It to the Web Services 
connector instead of the Legacy Listener 
connector.

Solution 2:

Before connecting Connect-It to the Legacy 
Listener connector, do the following:

 1. Add  usethreading:0 in the sc.ini file, which 
is located in <Service Manager server 
installation path>\LegacyIntegration\RUN.

Note: For 64-bit RedHat Linux servers only, 
you can alternatively run the following shell 
commands as root:

# sysctl -w kernel.exec-shield=0

# sysctl -w kernel.randomize_va_space=0

 2. Start the legacy listener.
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Global ID Problem Workaround

QCCR1E67491 When the collation of the db instance is 
Chinese_PRC_BIN, Web service clients fail to 
connect to Service Manager (SM). Only ASCII 
operator names are supported, so only ASCII 
operator names can be used. 

Note: This issue only exists in Web service 
integrations. Therefore, the SM clients do not 
have this problem.

When SM is handling an incoming SOAP 
request, the authorization string is decoded by 
BASE64Decoder. SM uses the decoded string 
value to construct a UTF-8 string that is used in 
the RTE. However, the authorization string is in 
the header and SM does not know the charset or 
encoding of the underling string value, which is 
BASE64 encoded. 

Therefore, if the underlying string value is not 
UTF-8, this problem will occur. In SM, when 
fetching an operator record from the database, 
no matter what collation the database uses, the 
operator record finally will get a UTF-8 operator 
value. However, even if users put the same 
value in the authorization header, the operator 
name may differ because of the 
charset/encoding issue. Because of this, the 
operator will fail to log on.  

This is a limitation of SM. Do not use non-ASCII 
characters in operator names. Created a 
knowledge article (KM1442479) to document 
this limitation. 
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Global ID Problem Workaround

QCCR1E75182 HTML email truncates the body of the message 
and sends the HTML code without translating it.

When the content of an HTML email template 
exceeds 8192 bytes in size, the content will be 
truncated and displayed as HTML code.   

Make sure your HTML email templates do not 
exceed this size limit.

QCCR1E89890 Grouped Views are not correctly updated after 
logging a new Incident.  

When you log a new incident, to keep 
consistency with actual incidents, the group 
number is not updated. 

You need to click the "Refresh" button to update 
grouped Views.

QCCR1E72835 Add the ability to limit the memory consumed by 
individual threads in SM as specified by an 
Administrator.

The requested change is not implemented to 
avoid performance degrade.

No workaround is currently available.

QCCR1E77563 Signal 11 error is received when calling the 
toXMLString() routine of the Users object. 

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E88222 An unload file that is exported from an Oracle to 
an SQL Server database fails to import when the 
unload file already contains a RECORD_KEY 
field and the length of first unique key exceeds 
the db limitation.

This request is caused by the product running in 
an unsupported configuration. Change to a 
documented and supported configuration. If the 
problem still exists in a supported environment, 
contact HP Support.

To work around this issue, do not use 
"RECORD_KEY" as a SQL Name for a field in 
dbdict.  This field name is reserved by SM.  To do 
this, follow these steps:

 1. Enter dbdict in the SM command line box.

 2. Enter "esdquestions" in to the search field, 
and then click the Search button.

 3. Select the "record.key" field, and then 
change the SQL Name from "RECORD_
KEY" to anything else.

QCCR1E74808 After clicking the Cancel button in the Condition 
Editor from the Workflow Editor, the current tab 
sometimes becomes a blank screen and the tab 
cannot be closed.

No workaround is currently available.

HP Service Manager (9.32)Page 23 of 55

Patch 2 Release Notes
Known Problems, Limitations, and Workarounds



Issues  in SM9.32 and Patches
Service Manager  Issues

Global ID Problem Workaround

QCCR1E64377 In the web client, when a Configuration Item (CI) 
record is opened, the CI label does not show (or only 
shows for the first time) in the CI Visualization 
(Relationship Graph). This issue occurs only when 
JRE 6 is used.

As Oracle has fixed this Applet issue, JRE 6 
customers need to upgrade their JRE to the 
latest JRE6 or JRE7 on the machine that runs 
Internet Explorer or Firefox in order for CI 
Visualization to display CI labels correctly.

QCCR1E95418 CI Relationship Graph is not immediately refreshed 
after changing CI Relationships.

No workaround is currently available.

QCCR1E95725 Due to a known issue in JDK (bug id:7196513), CI 
icons are not displayed correctly in Firefox when 
Httponly cookies are enabled in the web application 
server. 

When Httponly cookies are enabled, users can 
only use Internet Explorer 7 or higher for CI 
icons to display correctly.  As Oracle has fixed 
the Httponly cookie issue as of JDK 7u6, users 
need to install the latest 32-bit JRE (7u6 or 
above) on the machine that runs Internet 
Explorer 7 or higher. 

QCCR1E95963 An error occurs when loading a dbdict twice in an 
unload file. The two dbdict records have the same 
name, but different key types:  the first one has unique 
key, while the second's key type is primary key. 

Do not export to an unload file a dbdict record 
whose key type has changed. 
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Global ID Problem Workaround

QCCR1E97260 When SSL is enabled between the web application 
server and Firefox, a ClassNot found Exception error 
displays in the workflow section of the Change form. 
This issue does not occur in IE or in Firefox without 
SSL enabled.

There are two workarounds:

 l Use Internet Explorer instead of Firefox. 

 l If using Firefox, import the client certificate 
into the Java console on the end user's 
machine. Here are the steps for Windows 7:

 a. Open Control Panel, and i n the Control 
Panel Search box enter "Java 
Control Panel".

 b. Double-click the Java console icon to 
open the Java console.

 c. On the Security tab, click Manage 
Certificates ....

 d. On the Certificates window, select 
certificate type: Client Authentication, 
and click Import.

 e. Follow the wizard and import the client 
user's certificate.

QCCR1E97492 Clicking the Back button on the CI Visualization page 
(which opens when you click More > Expand CI 
Visualization  in a CI record) causes a Firefox crash.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E97539 If JRE 7 (update 21 or greater) is used in the web 
browser, when the user opens a configuration item the 
browser displays a security warning: 

Block potentially unsafe components from 
being run?

The reason why this warning occurs is that as of Java 
SE 7 update 21, JavaScript code that calls code 
within a privileged applet is treated as mixed code and 
warning dialogs are raised if the signed JAR files are 
not tagged with the Trusted-Library attribute.

This warning does not indicate the Service 
Manager product is unsafe.

Ignore this warning and select Don't Block in 
the warning dialog to continue.

QCCR1E97603 If a format that contains a button with Enable 
condition is created or modified by using a SM9.31 
patch 1 server, when using it in SM 9.31 GA or earlier, 
the client crashes. However, formats created by using 
the SM9.31 GA or earlier server work fine.

Upgrade both of the SM server and client to the 
same patch level: SM 9.31 patch 1 or later.

QCCR1E94657 When PDCP4 is applied, the first group on the form is 
not shown in the Jump Address drop down list.  

Move the scroll bar to the top-most position and 
then you will see the first group.

QCCR1E97856 In a single-line text field, some special characters 
whose HTML code is &#x...; (where ... stands for a 
hex number) are not represented as their original 
format. Instead, they display as &#x...;. However, 
such characters are represented as the original format 
in other widgets (textarea, label, message panel, and 
so on).

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E98343 When you try to remove a group from the permission 
list of a Knowledge Category record, if you select the 
group by clicking on the white space in either cell and 
then click the "Remove" button, the group is still 
there. 

Before clicking the  "Remove" button to remove 
the group, try making the selection by clicking 
on the text in either cell.

QCCR1E98705 The image uploaded for a service catalog item 
displays as broken (a cross-mark).

Go ahead to save the current record. When you 
retrieve this record again, the image will display 
correctly.

QCCR1E93604 The HTTP Response Code is 200 instead of 400 
when a RESTful request uses an invalid sort field 
separator (for example, a plus symbol).

Use a valid sort field separator. 

QCCR1E94204 Because of the incorrect status, the operation could 
not proceed after merging a record.

Reset the status of this record (for example, 
reopen the closed record) and perform the last 
operation again.

QCCR1E94206 The last operation could not be repeated after merging 
a record because the  button for the last operation 
disappears. 

Reset the condition for the button in this record, 
for example, Reopen the closed record, and 
perform the last operation again.

QCCR1E96353 RESTful API: An incident record is successfully 
resolved when posting an incident resolve action with 
a blank "ClosureCode" and "Solution".

Validation is not performed for the fields. 

To work around this issue, validate them at the 
RESTful client side, or    manually add validation 
for the fields to the format control.

QCCR1E96391 Restful API: Results are in the wrong order when 
sorted by an array field.

This issue occurs because the  SM RTE does not 
support sorting by array fields. A list is returned 
without any error message.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E97898  Restful API: A 400 Bad Request error occurs when a 
RESTful API request is a cross-table join query.

The RESTful API framework supports simple 
queries and SM native queries.  

Currently RESTful API framework does not 
support cross-table SQL queries.   

QCCR1E98320 When a record is removed after being read, the Merge 
function still allows the user to merge the record and 
the user's input is lost. 

No workaround is currently available.

QCCR1E98227 In Approval Delegation wizard, go to another page (do 
not change the delegation module) after choose the 
operator to delegate in "Select Approval Groups" 
page, then back to "Select Approval Groups" page 
again. You will find a blank line is displayed in the right 
table, instead of the operator record.  

This is only a display issue, and will not impact 
the functionality.  If you need to remove the 
operator from the delegation list, choose the 
blank line, and then click the remove icon; 
otherwise the operator will be successfully 
delegated once you save the update. 

QCCR1E98576 when there are conflicted updates on system fields, 
the system displays the message "The conflicted 
fields cannot be merged. Reload the record.", 
whereas the Merge  button is available. Actually, the 
merge function should not be available in such case. 

Ignore the Merge button. Reload the latest 
record to edit this record again.

QCCR1E98398 When you are updating a record and adding 
attachments to this record, if your updates conflict 
with another users' updates or the updates of a 
background process, the attachments will be lost after 
either automatic or manual merge.

After automatic or manual merge, add the 
attachments again before saving the merged 
result of the record.
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Global ID Problem Workaround

QCCR1E98411 SRC failed to retrieve service catalog items from SM 
on upgrade from SM 7.11 to SM 9.32.

In the svcCatalog dbdict, the id.attach field is 
character type, which should be number type. 
The id.attach field is an alias of the id field in the 
svcCatalog table.

To fix the issue, change the field type using the 
Dbdict Utility.

QCCR1E98606 When purging all duplicated records for upgrade, the 
following error message occurs: 

No display screen named "kmgroup.save" found 
 

No workaround is currently available.

QCCR1E98618 Subcategory data on the Incident form is not available 
after upgrading from ServiceCenter 6.2 to Service 
Manager 9.32.

Subcategory data is not upgraded.

If necessary, manually add the subcategory 
data.  

 1. Enter db in the SM command line box.

 2. In the Table field, enter subcategory, and 
click Search. 

 3. For each Catagory in the dropdown list, add 
the following Areas (enter a value in the 
Area field and click Add):  access, data, 
failure, hardware, performance, and 
security.
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Global ID Problem Workaround

QCCR1E98713  After applying an upgrade, the following error 
message occurs:

Unable to open file <file path> for writing  
 

This error has no impact on the upgrade, and can 
be ignored.

To prevent this message from occurring, do the 
following before applying an upgrade:

 1. In Database Manager, search for table 
help.

 2. Double-click help.detail.

 3. Enter the following values, and click 
Search:

File Name: formatctrl  

Format: formatctrl.maint.seq.b  

Term: Format Control maintenance 
- Sequentially Numbered fields  

 4. Click Delete to delete the record.

QCCR1E98298 Survey Integration: If you use an invalid parameter 
name when you configure a survey with an API-based 
connector, the parameter is replaced with an empty 
value incorrectly. 

Do not use invalid parameter names.

QCCR1E98299 Survey Integration: When you use the Mass Update 
utility to update multiple survey records, ruleset 
validation does not work.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E98475 With Process Designer Content Pack 9.30.3 applied, 
the Merge functionality does not work when a user 
clicks Save & New in an interaction record opened 
through a search. 

 1. Open an interaction through a search.

 2. Update the Title.

 3. Another back-end process has updated the Title 
to another value.

 4. Click Save & New. An error occurs: This 
record has changed since you selected 
it.

You cannot perform Merge for the conflicted 
updates as expected.

If you encounter the error "This record has 
changed since you selected it." when clicking 
the Save & New button on an interaction 
opened through a search, to avoid abandoning 
your updates, do not use the Save & New 
button to save your updates; instead, first click 
the Save button to save your updates with the 
merged result, and then register a new 
interaction from the navigation menu.

QCCR1E99998 The following text string in the web tier is not 
localized: 

File: 
<webtier-9.32.war>WEB-INF/lib/cwc-
9.32..jar/com/hp/ov/cwc/web/login.properties
 

Text: 
Logout.WarningMessage.CloseBrowser=Please 
close your browser window.

Manually localize it using the native2ascii 
tool. For detailed steps, see the SM9.31p2 
Release Notes.
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Service Request Catalog Issues

Global ID Problem Workaround

QCCR1E90074 When entering a search string in Service 
Request Catalog, auto-complete does not work 
if the browser's preferred language is set to an 
East Asian language (for example, Simplified 
Chinese).

No workaround is currently available.

QCCR1E98339 Custom fields do not load the DEFAULT 
company value when the checkout panel is 
empty for one of the three checkout panels of 
your company.

After upgrade, you should manually add the 
same structure configuration of the DEFAULT 
company for the empty checkout panel of your 
company. For example, before upgrade, you, as 
an SRC administrator, only defined custom 
fields for the Service Catalog checkout panel for 
your company. After upgrade to SM932, if you 
want to use the support checkout panel and 
generic support checkout panel in SRC 
correctly, you need to manually add OOB 
configurations for the Support Catalog  and 
Generic Support checkout panels, which you 
can copy from those panels of the DEFAULT 
company.
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Backup and Backout Instructions
In case you need to restore your Service Manager system to its original state after installing the 
component patches in this release, make necessary backups before each patch installation. If a 
rollback is needed, follow the backout instructions.

Server
Backup

Before applying the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.30\Server.

Note: If you have a horizontally scaled system, be sure to back up the server installation folder 
for each server instance.

Backout

Service Manager 9.32 supports FIPS mode. To run SM in FIPS mode, you must upgrade your 
database to the 256-bit AES encryption algorithm. Once you change all of the encrypted fields to 
use the new 32 character encryption you cannot roll back the RTE and still read the encrypted data.

After installing the patch, do the following to backout:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because 
the version of the embedded Tomcat may have dependency on a specific server version.

Note: If you have a horizontally scaled system, make sure that every server instance is 
replaced with its  backup.

 4. If you have also loaded platform unload files required for your server changes, you must also 
roll back the application changes made by the unload files. See "Applications" on page 35.

 5. For Unix-based platforms other than Linux, make a backup of your JRE if you have not yet 
upgraded to JRE 1.7. 

 6. Restart the Service Manager server.

Web Tier
Backup
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Before deploying the new web tier, make a backup of the following items:

 l web.xml file

 l application-context.xml

 l log4j.properties

 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-<version>.war (webtier-ear-
<version>.ear) file.

Backout

To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.

Windows Client
Backup

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are 
stored in this folder.

Note: This is the out-of-the-box home directory, and could differ from yours if you made 
changes  to <Client>\configuration\config.ini file. If so, back up the files from the 
location specified in that file.

 2. Make a backup of your certificate configuration files if any (Window > Preferences > HP 
Service Manager > Security). For example, your CA certificates file and client keystore file. 

Backout

 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.
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Applications
If you plan to upgrade your applications to this release level, make a backup of your database 
before the upgrade, in case you need to restore your database after the upgrade. Creating a backup 
of the entire database and restoring the database if needed is a better approach for a full 
applications upgrade.

If you plan to load individual unload files in this release, follow the backup and backout instructions 
below.

Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to make a backup of the files to be modified by an 
unload file, because Unload Manager can create a backup of your old data during the 
installation of the unload; if your application version is other than any of these, Unload Manager 
is not available and you can use Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and 
browse to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this 
unload.
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See the following figure for an example.

This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict 
record of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.
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 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is 
not available in your application version) to roll back to your old data, as described in the 
following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click 
Next. Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.
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Knowledge Management Search Engine
To backout your Knowledge Management (KM) search engine changes, make a backup before your 
KM patch installation.

Note: Keep in mind that you also need to roll back KM-related server side and application side 
changes. For details, see the Server and Application backup and backout Instructions.

Backup

Before applying the KM patch and upgrading the JDK and KM embedded Tomcat, do the following:

 1. Make a backup of the search engine installation folder. For example, C:\Program 
Files\HP\Service Manager 9.30\Search Engine Backup

 2. Make a backup of the files to be modified by the unload files in the KM patch.

 3. Make a backup of your schemastub.xml file under directory <SM server>/RUN/km/styles/.

Backout

After installing the patch, do the following to backout:

 1. Stop your KM search engine.

 2. Remove the existing search engine installation folder.

 3. Copy the backup folder back.

 4. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.

 5. Be sure to roll back KM related changes on the SM server and application sides, including the 
kmsolr unloads files and the server's schemastub file.

 6. Restart your KM search engine.

 7. Perform a full re-indexing on all of your knowledgebases.
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Installation Notes
This section provides instructions on installing each component in this patch release.

Before you proceed, HP recommends that you consult the latest Service Manager 9.32 Support 
Matrix and the Compatibility Matrix for Service Manager Applications Content at:

http://support.openview.hp.com/sc/support_matrices.jsp

For more information, see "Service Manager Support Matrix and Applications Content Compatibility 
Matrix" on page 54.

Digital Signature Notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has 
been updated to use a new VeriSign root certificate. On a Windows system that does not have the 
new VeriSign root or intermediate certificate installed, when the user right-clicks the file and then 
goes to Properties > Digital Signatures > Details, a verification error will display: “The certificate 
in this signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate 
as documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140
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Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.32.2004-P2_
<OS>.zip (or .tar), which contains updated files of the Service Manager server. These files add to 
or replace the files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, 
legacyintegration, and platform_unloads directories. 

Note: If using an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 is 
required for SM9.30p5, SM9.31, SM9.32 and later. See the latest Service Manager 9.32 
Support Matrix at http://support.openview.hp.com/sc/support_matrices.jsp. 

Built-In Troubleshooting Tool (SM Doctor)

Additionally, this server patch includes an installation of the HP Service Manager Doctor (SM 
Doctor) tool. The server patch will install the tool in the [SM Server Root]\([SM Server Root]/)
smdoctor directory. For information on how to use this tool, see the Guides and reference > 
Troubleshooting > HP Service Manager Doctor section in the online help.

Upgrade Paths

This server patch must be applied on top of one of the following versions/patch levels of the 
SM server:

 l SM9.30 GA

 l SM9.30 Patch/Hotfix

 l SM9.31

 l SM9.31 Patch/Hotfix

 l SM9.32

The following server upgrade paths are recommended:

 l New customers: Install the SM9.30 GA server, and then directly apply this server patch;

 l Existing SC6.2, SM7.11, and 9.21 customers:  Uninstall the old server, install the SM9.30 GA 
server, and then apply this server patch;

 l Existing SM9.30, 9.31, and 9.32 customers: Apply this server patch.

For installation instructions of the SM9.30 GA server, see the Service Manager 9.30 Interactive 
Installation Guide, which is available from the HP Software Manuals Site: 
http://support.openview.hp.com/selfsolve/document/KM1195794

For installation instructions of the server patch, see "Server Patch Installation Steps" on the facing 
page.

Compatibility Mode for Installation on Windows Server 2012
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As of this release, Windows Server 2012 is supported. Be aware that compatibility mode is required 
for installing the SM9.30 GA server on Windows Server 2012 (not required for Windows Server 
2008). To run your server installation in compatibility mode, do the following:

 1. Right–click the server's setupwin32.exe file icon.

 2. Click Properties > Compatibility.

 3. Click Run this program in compatibility mode for and select Windows Vista (Service 
Pack 2).

 4. Click Apply and OK.

 5. Run the setupwin32.exe file to complete the installation.

When uninstalling your server on Windows Server 2012, you should also use compatibility mode. 
To do so, set your Windows server uninstaller file (_uninst\uninstaller.exe) to compatibility 
mode as described above and then uninstall the server using the uninstaller or from your Control 
Panel.

Server Patch Installation Steps

Caution:  

 l The server patch will upgrade your embedded Tomcat to version 6.0.36, and therefore 
requires additional steps.

 l The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2. 

 l Starting with SM9.31p2, the SM server requires JRE 1.7. For Windows and Linux,  the 
embedded JRE has already upgraded to version 1.7; for other Unix-based platforms, you 
need to manually perform this JRE upgrade. 

The JRE upgrade will cause external web service calls over SSL to fail if the remote 
endpoint does not support Server Name Indication (SNI), which is by default activated in 
JRE 1.7. Once Service Manager is upgraded to use JRE 1.7, it starts to use SNI 
extensions during the SSL handshake. If the remote endpoint does not support SNI, the 
web service call will fail with an error message. To solve this issue, do either of the 
following: 

 n Activate SNI at the remote end point (recommended)

 n If the remote endpoint does not support SNI extensions, and SNI cannot be activated, 
add the following JVMOption<n> parameter either to the sm.ini file, or to the start 
command of the servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

Note: If you have a horizontally scaled system, you must upgrade all of your server instances.
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 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backup and Backout 
Instructions" on page 33.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36 
when you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 

Note: This step is required only when you are upgrading from a server version earlier than 
9.31p2. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.

 7. Extract the compressed files for your operating system into the main Service Manager 
directory on the server. The default path is: C:\Program Files\HP\Service Manager 
9.30\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to 755.

 9. For the following Unix servers, manually upgrade to JRE1.7 if you have not already done so.

 a. Install correct JRE or JDK version for your specific platform.

Solaris 10 JRE1.7 (update 15 or greater)

Solaris 9 JRE 1.6 (upgrade 20 or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

Note: Service Manager can run on Solaris 9 with JRE 6. However, HP recommends 
that you upgrade to Solaris 10 to take advantage of JRE 7. 

If you still want to run the server on Solaris 9, an extra configuration is required. For 
details of the configuration, see "Warning when Running the Server on Solaris 9 with 
JRE 6" on page 7.

 b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have JDK1.7 
installed) or JRE1.7 (if you have only JRE1.7 installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links.
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 d. Run the following command to check that the JRE version is 1.7: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them 
in the new RUN/tomcat folder.

 11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been 
updated to a newer version. Either keep your old file by copying it back or keep the updated 
version (a KM knowledgebase full reindexing is then required).

 12. Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required 
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The 
purpose of this step is to prevent stale license information from being kept in the system. 
In a scaling implementation, you can run this command from any one of your servers.

 13. Restart the Service Manager server.

 14. Restart the Service Manager clients.

 15. Check the version in Help > About Service Manager Server.

The server should be Release: 9.32.2004.

Web Tier Installation
The web tier update consists of a compressed file, sm9.32.2004-P2_Web_Tier.zip, which contains 
the installation files (both the .war and .ear files) for installing the SM9.32 web tier. Installing the 
new web tier will upgrade your web client to this release level.

The installation steps are the same as installing the SM9.30 web tier. The specific installation 
process depends on your particular web application server. For detailed steps, see the Service 
Manager 9.30 Interactive Installation Guide, which is available from the HP Software Manuals Site: 
http://support.openview.hp.com/selfsolve/document/KM1195794

New Customers

You only need to install the new web tier using the .war or .ear file from the sm9.32.2004-P2_Web_
Tier.zip file in this release. For installation instructions, see the Service Manager 9.30 Interactive 
Installation Guide.

Existing Customers

To upgrade your web tier to this patch level, you need to back up and uninstall your old web tier and 
then install the new web tier.  The upgrade does not automatically save your web tier 
customizations. To keep your changes, you must back up your customized files and restore your 
customizations in the new deployment.
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Note on Tomcat 7.0: If you plan to deploy the web tier on Tomcat 7.0 using the Tomcat Manager, be 
sure to set the max-file-size and max-request-size parameters (default: 52428800) in the 
<Tomcat 7.0_Home>webapps\manager\WEB-INF\web.xml to an appropriate value greater than the 
web tier .war file size; otherwise the deployment request will be rejected because the web tier .war 
file exceeds the default maximum values. This restriction does not exist in Tomcat 6.0.

To install the new web tier:

 1. Make necessary backups. For details, see "Backup and Backout Instructions" on page 33.

 2. Delete or uninstall the existing web tier .war (or the .ear) file.

 3. Clear the cache of your web application server.

 4. Deploy the new webtier-9.32.war (or the .ear) file following the instructions in the Service 
Manager 9.30 Interactive Installation Guide.

Note: It is best practice to deploy with a unique context root. For example: /webtier-9.32.2004

 5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final 
deployment. Do this for application-context.xml as well as any other files you may have 
customized (such as style sheets and splash screens).

 6. Make any new customizations necessary for your deployment.

 7. Restart the web application server.

 8. Check the version by clicking the HP logo (About HP Service Manager) icon.

The web tier version should be: 9.32.2004.

Windows Client Installation
The Windows client update consists of a compressed file, sm9.32.2004-P2_Windows_Client.zip, 
which contains the executable installation files of the new Windows client.Installing the new 
Windows client will upgrade your Windows client to this release level.

The installation steps are the same as installing the SM 9.30 Windows client. See the Service 
Manager 9.30 Interactive Installation Guide, which is available from the HP Software Manuals Site: 
http://support.openview.hp.com/selfsolve/document/KM1195794

New Customers

You only need to install the Windows client using the executable files from the sm9.32.2004-P2_
Windows_Client.zip file in this release. For installation instructions, see the Service Manager 9.30 
Interactive Installation Guide.

Existing Customers

You need to back up and uninstall the old Windows client, and then install the new Windows client.

To install the new Windows client:
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 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backup and Backout Instructions" on page 33.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe from this Windows client patch to install the new client by following the 
instructions in the Service Manager 9.30 Interactive Installation Guide.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.32.2004.

Windows Client Configuration Utility Installation
This release does not contain any update for the Windows Client Configuration Utility. The latest 
Windows Client Configuration Utility package has been shipped with the SM9.32 release.

You can download this package from 
http://support.openview.hp.com/selfsolve/document/KM00495874

For installation instructions, see the Service Manager 9.32 Release Notes.

Applications Update Installation
The latest Applications package has been shipped with the SM9.32 release.

You can download this package from 
http://support.openview.hp.com/selfsolve/document/KM00495886

For installation instructions, see the Service Manager 9.32 Release Notes.

Application Unload Installation

Note: All unload files in the server's platform_unload directory in this release have been 
already merged into the Service Manager 9.32 applications. These files are provided just in 
case you do not plan to upgrade to applications 9.32 while still want to take advantage of the 
relevant features/fixes.

If a platform fix (in most cases, a server fix) also requires an applications change to resolve the 
relevant issue, an unload file is provided. Unload files introduced in earlier patches are also included 
in this cumulative release. If you have not already applied them for a previous patch, you should 
also apply the unload files that are intended for your applications version. For more details about 
these applications updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm9.32.2004_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)
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Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload File Naming Convention

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. 

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For 
example, SM921P2, which means the unload file comes with the server updates in Service 
Manager 9.21 patch 2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 patch 
16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, 
SM711, which means the unload file is intended only for Service Manager applications version 
7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 
9.20, and 9.30 (which are compatible with Service Manager server 9.30), unless otherwise 
specified in the unload file description. For information on the applicable applications versions for 
each unload file included in the current patch, see Unload Files Included in the Current Patch.

Unload Files Included in the Current Patch

The following are unload files included in the current patch release.

Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E9939
8_
SM932P2.unl

9.32p2 7.11, 
9.21, 
9.30 and 
9.31

Fixes the issue that the inactive timer function does 
not work if the version of applications is lower than 
the server version.

Associated server fix: QCCR1E99398

QCCR1E3132
4_SM932.unl

9.32 7.11, 
9.21, 
9.30 and 
9.31

Fixes this issue : With Syslog audit turned on, only a 
syslog record showing login is created; no record for 
logoff is recorded if the user does not log out 
"normally."

Associated server fix: QCCR1E31324
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E9680
2_
SM931P3.unl

9.31p3 7.11, 
9.21, 
9.30 and 
9.31

Changes the behavior when handling web service 
request user passwords. See the SM9.31p3 
Release Notes.

Associated server fix: QCCR1E96802

QCCR1E5276
7_SM931P3_
SM930.unl

9.31p3 9.30 Fixes the issue that users cannot add data policy 
definitions on joined tables. 

Note: You do not need to load this unload if you are 
running on SM9.31, 9.21, or 7.11 applications.

Associated server fix: QCCR1E52767

QCCR1E7672
4_SM931P2_
SM930.unl

9.31p2 9.30 and 
9.31

Fixes the issue that after deleting the unique key of 
cm3r, a signal 11 happened while doing an IR 
regeneration.

Associated server fix: QCCR1E76724

QCCR1E7622
7_SM930P6_
SM930.unl

9.31 9.30 Contains the code changes to support localization of 
incident/change priority and urgency strings for the 
9.31 Mobility Client.

Note: Not needed for the SM9.32 or later 
Mobility client.

QCCR1E7879
4_SM930P6_
SM930.unl

9.31 9.30 Removes incident.assignee when a Web Service 
call specifies the assignee as 'NULL' through the 
SM9.31 Mobility Client.

Note: Not needed for the SM9.32 or later 
Mobility client.

QCCR1E7679
6_SM930P6_
SM930.unl

9.31 9.30 Provides the ability to turn on debugging dynamically 
for user sessions or schedulers.

Note: This unload requires the SM9.31 server.

QCCR1E7109
9_SM930P5_
SM711.unl

9.30p5 7.11 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E7109
9_SM930P5_
SM920.unl

9.30p5 9.20 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E7109
9_SM930P5_
SM930.unl

9.30p5 9.30 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E7113
9_SM930P5_
SM930.unl

9.30p5 9.30 Works with server fix QCCR1E71139 to solve this 
issue: When Service Manager is configured to use 
LDAP as the authentication data source, the user is 
still forced to change the password if the user is 
expired in the local database.

QCCR1E3194
1_SM930P4_
SM930.unl

9.30P4 9.30 Enables users to use a pre-configured decimal 
symbol when completing numeric fields. 

Note: This enhancement requires a 9.30p4 or 
later server; however if you are using RTE 
version 9.30 with applications version 7.11 or 
9.20, do not load this unload file; you can safely 
upgrade your server to 9.30p4 or later without 
applying this applications change.

Associated server fix: QCCR1E31941.

QCCR1E7345
2_
SM930P4.unl

9.30P4 7.11 - 
9.30

Enables Mandanten restricting queries to be updated 
correctly after a profile is edited.

Associated server fix: QCCR1E71897

QCCR1E6707
2_SM930P4_
SM930.unl

9.30P3 7.11 and 
9.20

Enables users to take advantage of the new 
KMStatusListener background process.

Note: This unload file is not needed for 
applications version 9.30 or later, which 
supports only the Solr Search Engine.

Associated server fix: QCCR1E67071
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E7016
3_SM930P4_
SM711.unl

9.30P3 7.11 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E7016
3_SM930P4_
SM920.unl

9.30P3 9.20 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E7016
3_SM930P4_
SM930.unl

9.30P3 9.30 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E6764
7_
SM930P3.unl

9.30P3 7.11 - 
9.30

Updates the exception message that occurs in the 
request response when closing an interaction by 
calling CloseInteraction from a web service without 
specifying the localSolution field in the request.

Associated server fix: QCCR1E54192

QCCR1E6761
0_
SM930P2.unl

9.30P2 7.11 - 
9.30

Enables you to block potentially dangerous 
attachments.

Associated server fix: QCCR1E64290

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to load an unload file, because Unload Manager can 
help you create a backup of your old data and reconcile conflicts during the installation of the 
unload; if your application version is other than any of these, Unload Manager is not available 
and you can use Database Manager instead. 

To load an unload file using Unload Manager:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:
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 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:

 1. Make sure the Windows client is configured for server-side load/unload.
 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backup 
and Backout Instructions" on page 33.
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 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this 
field blank.

File Type Select the source operating system of 
the unload file.

Messages Option —  

All Messages Select this option to see all messages 
that Service Manager generates 
loading the file.

Messages Option —  

Totals Only Select this option to see only the total 
number of files Service Manager 
loads.

Messages Option — 
None

Select this option to hide all 
messages that Service Manager 
generates when loading the file.

 7. Click Load FG.

Service Request Catalog (SRC) Installation
This release does not contain any SRC update. The latest SRC package has been shipped with the 
SM9.32 release.

You can download this package from 
http://support.openview.hp.com/selfsolve/document/KM00495894

For installation instructions, see the Service Manager 9.32 Release Notes.

Mobile Applications  Installation
This release does not contain any mobile application update. The latest Mobile Application package 
has been shipped with the SM9.32 release.

You can download this package from 
http://support.openview.hp.com/selfsolve/document/KM00495880

For installation instructions, see the Service Manager 9.32 Release Notes.
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Knowledge Management (KM) Update Installation
This release does not contain any KM update. The latest KM package has been shipped with the 
SM9.32 release, which you can download from:

http://support.openview.hp.com/selfsolve/document/KM00495878

For installation instructions, see the Service Manager 9.32 Release Notes.

ODBC Driver Update Installation
This release does not contain any ODBC Driver update. The latest ODBC Driver package  has been 
shipped with the SM9.30p4, SM9.30p5, and SM9.31 releases.

You can download the package from:

 http://support.openview.hp.com/selfsolve/document/KM00207925

The ODBC Driver package contains the following updated files:

 l Scodbc32.dll

 l sci18n.dll

 l sccl32.dll

To install the ODBC Driver update:

 1. Extract the files to your ODBC Driver installation folder, for example: C:\Program 
Files\Peregrine Systems\ServiceCenter 6.2\ODBC Driver.

 2. When prompted, replace the three old DLL files with the new ones.

Language Pack Installation
This release does not contain any language pack update. The latest language pack packages have 
been shipped with the SM9.32 release.

Service Manager 9.32 includes language packs for the Service Manager server, for 15 supported 
languages other than English.

For more information, see the Service Manager 9.32 Release Notes.

Online Help Installation
This release does not contain an updated version of the online help. The latest online help package 
has been shipped with the SM9.32 release.

You can download this package from: 
http://support.openview.hp.com/selfsolve/document/KM00493466
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To install the online help, follow the instructions in the Service Manager 9.30 Interactive Installation 
Guide, which you can download from:

http://support.openview.hp.com/selfsolve/document/KM1195794
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Service Manager Support Matrix and 
Applications Content Compatibility Matrix

The Support Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

The Applications Content Compatibility Matrix (named Compatibility Matrix for Service Manager 
Applications Content) provides compatibility information for Service Manager applications content 
packs (for example, Process Designer Content Packs). 

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Support Matrix and Applications Content Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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